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1. Introduction 
Control4® Composer Home Edition (HE) is a powerful software application that lets you, the home or 
business owner, customize your own Control4 system. Your Control4 Dealer has installed and 
configured your Control4 system using the professional version of Composer. The Composer HE 
application was created just for you.  
 
This document applies to Control4 Operating System (OS) Release 2.3.0 (OS 2.3.0). Check with your 
dealer to make sure you have Composer HE for OS 2.3.0. 

1.1 Purpose 
The purpose of this document is to give the reader an introduction to the Composer HE application 
and what you can do with it. For more detailed information, see the Composer HE User Guide. 
 
Note: Words that appear in red are either in the Glossary or provide examples, tips, and important 
information. 

1.2 Related Documents and Resources 
You can find the following related documents in PDF or web help format at this location: 
http://www.control4.com/residential/products/resources/. 

• Composer Home Edition User Guide (200-00170) 
• Control4 System Quick Start Guide (200-00153) 
• Control4 System User Guide (200-00001) 
• Control4 System Remote Control SR-250 User Guide (200-00152) 
• Composer Media Edition User Guide (200-00171) 
• Control4 MyHome Setup Guide for Homeowners (DOC-00004) 

1.3 What’s New in This Release? 
The Control4® Composer HE software and hardware updates are detailed below. This version 
includes changes for OS 2.3.0 and later (see the latest version first). 

1.3.1 OS 2.3.0 

1.3.1.1 Hardware and Software Support 
• Added two (2) new agents. 

• Advanced Lighting. This agent lets you edit existing Lighting Scenes or create new 
scenes without having to call your dealer every time you want to make a scene change. 
With this agent you can: 

- Track and indicate a Lighting Scene state 

- Toggle a scene from a single button 

- Ramp or fade scenes 

http://www.control4.com/residential/products/resources/�
http://www.control4.com/residential/products/resources/�
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- Set delays within scenes for pathway lighting or dramatic effect 

- Set up complex scene sequencing with multiple actions for each light within a 
scene 

- Set up to flash a light within a scene – ideal for “panic” scenes 

• Access. This agent limits unauthorized access through password protection and 
selectively hides certain icons on the Navigators, giving home and business owners more 
control over their systems. 

• New lighting interface. This page on Control4 Navigators makes it easier than ever to control 
lights and Lighting Scenes in a residence or business. For this release, the ability to edit 
Lighting Scenes is available on Touch Screens and On-Screen Navigators only. See the 
Control4 System User Guide for details. Note: You’ll need to make sure your dealer adds the 
Advanced Lighting agent to the project before you can edit Lighting Scenes on a Navigator. 

• We added driver support for a new line of Panelized Lighting devices for ‘new construction’ 
installations (to be released soon). Now you can control the whole house from one keypad, 
eliminating the need for wall clutter (an assortment of switches and dimmers installed on one 
wall). Check with your dealer for details. The Panelized Lighting product line includes: 
• 5-Slot Panel (C4-DIN-5PAN) 
• 2-Slot Panel (C4-DIN-2PAN) 
• 8-Channel Dimmer (C4-DIN-8DIM-E) 
• 8-Channel Dimmer Terminal Block (C4-DIN-TB-8DIM) 
• 8-Port Ethernet Switch (C4-DIN-8ESW-E) 
• 8-Port Ethernet Switch Terminal Block (C4-DIN-TB-PO) 
• 8-Channel Relay (C4-DIN-REL-E) 
• 8-Channel Relay Terminal Block (C4-DIN-TB-8REL) 
• 8-Channel 0-10V Dimmer (C4-DIN-8TV-E) 
• 8-Channel 0-10V Dimmer Terminal Block (C4-DIN-TB-PO) 

• Changed the 'breadcrumb' bar on the Touch Screens, MyHome-PC/Mac, and MyHome-iPad 
devices. Cleaned up the words and icons on the right side of the breadcrumb bar for 
consistency. See the Control4 System User Guide for details. 

1.3.1.2 New or Updated Sections 
• “Getting Started.” Added reference to new devices. 
• “Agents.” Added details about the new agents. 
• “Configuring the Control4 System Using Intelligent Agents.” Added details about the new 

agents. 
• Moved contents of “Using Composer HE to Customize Your System” into “Exploring the 

Interface > Views.” 
• Combined some sections together. 
• General edits. 
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1.4 Introducing Composer Home Edition (HE) 

1.4.1 What You Can Do in Composer HE 
You can: 

• Customize your Control4 system  
• from a Windows PC on your home's local network. 
• from any Internet-connected Windows PC (this capability requires a Control4 4Sight 

subscription). 
• Monitor and control 

• Dimmers, switches, and keypads, 
• Wireless Thermostat, 
• Security system, or 
• other devices from your Windows PC. 

• Configure the Control4 devices on your system to 
• set LED colors on lights and keypads, 
• set the ramp rates and the default levels of your Control4 Wireless Dimmers, 
• set your Control4 Wireless Thermostat schedule, and 
• program the device-specific buttons on your Control4 System Remote Control. 

• Manage your digital music and DVD collections. 
• Configure your system using a variety of intelligent agents (your dealer must add the agent to 

your Composer project first): 
• Use Media Scenes to tie together the audio source selection, volume control, and on/off 

state of multiple rooms so that they work as one. 
• Use the E-mail Notification agent in programming to notify you when events occur on your 

system. 
• Create an Announcement agent to make announcements that display on Touch Screens 

and On-Screen Navigators. 
• Create and modify custom Lighting Scenes. 
• Use the Scheduler agent to program events based on date, time of day, and 

sunrise/sunset. 
• Create your own Wakeup scenes. 
• Use the Macros agent to create a common programming script. 
• Do much more with other agents. See “Agents” later in this guide. 

• Program your system to behave as you want it to. Tie together all the capabilities of the 
Control4 environment into a single, controllable, and programmable system. 
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1.4.2 Restrictions 
While Composer HE is a fully-functional application that lets you customize your Control4® system, it 
does not provide all the functionality of the Composer Professional (Composer Pro) version that your 
Control4 Dealer uses. Should you ever get stuck, your dealer can help. 
  
Contact your Control4 Dealer if you ever need to 

• create a new Control4 system, 
• add devices to your system (or remove devices), 
• create or edit drivers for third-party products, 
• install updates to system software, 
• perform complex programming, or 
• perform other tasks that are beyond the capabilities of you or the software. 

  
If your system has been configured to connect to Control4's 4Sight service, your dealer can perform 
many of these services over the phone and on the web without having to schedule a service call at 
your home. 

1.4.3 Important Basic Principles 
Your Control4® Dealer or Installer has installed and configured your Control4 system to your 
specifications based on your purchase agreement. While individual Control4 Dealer policies may vary, 
most dealers will charge you for additional service calls unless you have a service contract. 
 
One of the benefits of using Composer HE is that you can customize parts of the Control4 system 
yourself which can save you some money. Should you require your dealer's assistance, however, you 
must be prepared to pay for that assistance. 
 
CAUTION! When using Composer HE, you are configuring your own Control4 system. While this 
gives you a great deal of capability, it also carries some risk for which you must be prepared to take 
responsibility. 
 
This section describes some of the basic principles when using Composer HE on your Control4 
system. It is important to understand these principles and accept the risk and responsibilities that 
come with customizing your system yourself. 
 
1. Changes you make in Composer HE. When you connect to Director and customize your 

system, the changes are effective immediately. Whether you're changing LED colors or Dimmer 
ramp rates, performing complex programming, or creating agents, Director immediately modifies 
your system configuration. 

2. There is no ‘Undo’ capability. If you make a change you don't like, there is no way to "undo" 
that change. You have to configure or program the project back to the way it was, or load a 
backup copy of the project you've previously saved. Therefore, Control4 recommends that you 
always make a backup copy when you save your project. 

3. You can save and restore your Control4 system. An important capability provided in 
Composer HE is the Backup or Backup As options; these options save your system 
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configurations to a project file on your PC’s local drive. If you ever need to restore the system to 
the state you saved, you simply load the saved project file. 

4. When you load a project file, you reset your current system configuration. Loading a project 
file on your system clears and resets any current system configurations you’ve made in an 
existing project. You will lose any customization you've done; the changes are not in the project 
file you load. 

5. Project files can be backed up with and without media. When you back up your project file, 
you can create the backup with or without media. If you load a project file that doesn't have any 
media associated with it, you will lose the media that was associated with your current system. It's 
always a good practice to back up your project with your media when you exit Composer. If you 
ever need to restore your system, your Media Database is still intact. Tip: If you forget to back up 
your media, you can always go back to a previous backup with the media loaded. This may 
change your system configuration, however, to the old configuration in that backed up project. 

6. You can separately export media and playlists. You can export the Media Database 
information for each media source on your Control4 system. You can also export playlists. If you 
import media and playlists, the current media list for that media source and the current playlists 
will be cleared and replaced with the media in the file you are importing. 

7. Backups with media and exported media lists only include the Media Database 
information. Backups and exported media lists contain the Media Database information used by 
the Control4 system. These lists do not contain the actual media (MP3) files. To back up the 
media files, you should separately back up the media source (to a Controller with disk space, 
USB storage, or network file storage) when you exit Composer HE. 

8. Programming can be associated with multiple events. Control4 system programming lets you 
program your system to perform similar tasks in a variety of ways. For example, you can set the 
LED color as a device property, and you can change that property in programming too.  

  
Note: Pay close attention to your programming changes so that you don't inadvertently change 
the behavior of your system in an undesirable way.  

  
9. Your system may become inoperable due to certain types of changes you can make using 

Composer HE. It is possible that you could make your system inoperable using Composer HE. In 
most cases, you can recover your system using a backup project file. However, if you can't 
recover your system using a backup project file, contact your Control4 Dealer for assistance. Your 
dealer can restore your system back to an operational condition. 

2. Getting Started 
Composer HE is a Windows XP-based PC program that has an intuitive drag-and-drop interface 
which gives you the opportunity to view and configure your devices, manage your media, and create 
simple programs, for example, changing Lighting Scenes, modifying custom buttons, and controlling 
behaviors among devices. The following screen displays when you first start Composer HE. 
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Composer HE main screen: 

 
  
The brains and heart of the system is the Control4 Controller, for example, the HC-800 Controller. The 
controller communicates with Control4 and third-party products compatible with Control4 to enable 
home automation and interaction of individual devices. Whenever the term “controller” is referenced in 
this document, it refers to any Control4 product that contains the Director software, for example, HC-
250 Controller, HC-800 Controller, the new Sony STR-DA2800ES with full Control4 Automation, the 
Sony STR-DA5800ES with full Control4 Automation, and so on. 
  
The sections in this guide will give you startup information so you can begin to use Composer HE. 
When you’re ready to start using Composer HE, refer to the Composer HE User Guide. 

  
In this document, you’ll learn how to 

• install Composer HE, 
• activate an account for Internet access, 
• start and close Composer HE, 
• connect to a Director, 
• begin to use the Composer HE interface,and  
• review the views and menu options. 

2.1 Installing Composer HE 
The following illustration shows how a small home network might be set up. The laptop shows the 
Control4® Composer software installed on it. Your Control4 Installer may have set up a network similar 
to this one. 
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2.1.1 Composer HE Software and Hardware Requirements 
• Control4 Primary Controller (for example, HC-800 Controller) added and configured to the 

Composer project 
• PC software and hardware: 

• Composer HE software  
• Microsoft.NET 1.1 and Support Pack 1 (installation automatically started from Composer 

Install either from CD or web) 
• Microsoft operating systems supported 

o Windows XP and Service Pack 2 (Home or Professional) 
o Windows Vista 
o Windows 7 

• 500 MHz processor or higher 
• 256 MB RAM 
• 80 MB hard disk space 
• Video card and monitor supporting resolution of 1024 x 768 or higher 
• Keyboard 
• Mouse 
• 1–2 Ethernet (CAT5) cables 

• TCP/IP-based home network (DSL/Cable Modem, Control4 Secure Gateway, router, or 
switch) to connect the PC to the controller 

• Internet connection (broadband required when using Remote Access or retrieving cover art)  
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• Windows Media Player 9 
• wireless access point (WAP) that supports 802.11 b/g/n (optional) 
• Installation software 
• Controller registration 

2.1.2 Install the Software 
To use Composer HE with your Control4 system:  
1. Install the Composer HE software on the PC that you will be using to configure your Control4 

system. Both your PC and your controller must be connected to your TCP/IP-based-home 
network. Composer HE is provided to you by your Control4 Dealer or Installer via a CD or an 
Internet URL path for download.  

  
Tip: Control4 recommends that you install Composer HE on a PC laptop. Laptops are very handy 
to move about the home or business as you set up your project and test your devices.  

  
2. Register and create a user account on the Control4 my.control4.com Internet site to activate 

Composer HE. Refer to the instructions in “Activating Composer HE.” 
  

To Install Composer HE: 
1. Download and run the installation program from the URL provided to you by your Control4 Dealer 

or Installer. The Installation link contains the Composer HE software and this Composer HE 
Getting Started as online help (a PDF of this guide is available on the Control4 website). The 
Composer HE User Guide (the companion to this document) is available on the Control4 website 
in web help or PDF formats. 

2. Select Install Composer. 
3. Follow the instructions provided to install Composer HE on your PC.  
4. When prompted by the Install program, select continue anyway to install the 'Remote Access 

Network Tunnel Adapter' on your PC. 
5. When the installation completes, click Finish. 
6. A Composer HE icon displays on your PC desktop if you selected to have it installed there. Click 

the icon to start Composer HE. 
 
Note: Before you can use Composer HE, you must create a my.control4.com account and 
register your controller. Follow the instructions next. 

2.2 Before You Use Composer HE 
Prerequisites 
Before you can use Control4® Composer HE, you and/or your installer need to  

• create an account at my.control4.com, 
• register your controller to your project so it works with the system, 
• set up Remote Access so your dealer can fix any problems remotely, 
• set up 4Sight for remote access to the system, and 
• activate your Composer HE software. 

  

http://www.control4.com/residential/products/resources/�
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The first time you start Composer HE, the system prompts you for your myControl4 4Sight account 
information and a Composer HE subscription code. 4Sight is a Control4 subscription Internet service. 
The 4Sight Internet connection works well when you're away from home and you want to receive 
email notifications or configure a device remotely using the Web Navigator. 
 
To activate Composer HE, create a my.control4.com account at http://my.control4.com (see below). 
There is no charge to create this account.  
 
Note: This setup may have already been done for you by your Control4 Dealer. If you don’t know 
whether this is true, check with your dealer either to obtain your account information (account name, 
email address, password, and registration code) or to verify whether this needs to be done. 
 
To use a 4Sight Internet connection, email agent, and Web Navigator services for one (1) year, you 
may use the 1-year 4Sight subscription included with each copy of Composer HE. Thereafter, you 
may want to purchase an annual 4Sight subscription from your Control4 Dealer so you can continue 
to enjoy its benefits. 

2.2.1 Create Your my.control4.com Account 
Everyone who has a Control4 system needs an account on my.control4.com. 
To set up your account: 
1. Using your Internet browser, go to http://my.control4.com.  

  

 
  

2. Click the link under Registering Your Controller, or click create account at the top of the page.  
  

http://my.control4.com/�
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3. At the Create Consumer Account page, fill out the account information (in three (3) major steps). 
Make a note of your Account Name, E-mail Address, and Password for future reference. You 
will need this information every time you log in to my.control4.com. 

4. Read through and agree to the Terms of Use. 
5. Click Create Account to create your account. 
 
The software asks you if you want to register your Controller. If you want to do this now, go to the next 
step.  

2.2.2 Register the System on my.control4.com 
If you haven’t already done so, go to http://www.my.control4.com to register your controller. Ensure 
that your my.control4.com account has been created. 
 
To register the controller:  
1. At the account Home page, click Register Your Controller to set up remote access. 
2. On the Complete Registration page, click Yes. 
3. On the Controller Registration Confirmation page, make note of the 10-digit registration code 

that displays. This code is time-sensitive and must be used within 10 minutes. It provides a 
temporary code used to exchange security parameters and set up the ability to create a secure 
connection between my.control4.com and the controller. 

4. Go to a Navigator (for example, a Touch Screen or On-Screen Navigator), and select More > 
Settings > Remote Access. 

5. On the Navigator, click the text box in Enter code, and then enter or paste the 10-digit 
registration code when the keyboard appears. 

6. When you are finished, select or press Activate. When activation is completed, you can use all 
media services, for example, the online media recognition service. 

7. (Optional) While you are at that page, you may want to enable Remote Access. Select Remote 
Access > Enable. This allows Control4 access for system updates, and is a required step in 
enabling Remote Access into your system by your dealer when needed (which also requires a 
4Sight subscription). 

http://www.my.control4.com/�
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2.2.3 Set Up Remote Access 
When you set up remote access for a Control4® system, you can log in to 4Sight from anywhere in the 
world and monitor or control settings in your home. You can use the 4Store website also. 
 
Prerequisites 
Use the Navigators or my.control4.com to set up Remote Access. If you’ve already done this in the 
previous section, you can skip these steps. 
 
To set up Remote Access from a Navigator: 
1. From the Control4 Home page of a Touch Screen or On-Screen Navigator, choose More > 

Settings. 
2. Select or press Remote Access. 
3. Select or press Remote Access > Enable. 

  
Notes:  
1. When you enable Remote Access, if you have a 4Sight subscription for this system (see “Setting 

Up a 4Sight Subscription”), you can enter your email address and password, and then securely 
log in to the home network from any Internet connection in the world. When you are in 4Sight, you 
can use the Web Navigator to monitor and control the lights, change the temperature (warm or 
cool the home remotely), or check whether any doors or windows were left open. Refer to “Using 
the Web Navigator” in the Control4 System User Guide for more information. 

2. If your system is registered on my.control4.com and the controller is registered, the system is 
accessible over remote access (without a 4Sight subscription) after a request by the Control4 
Dealer or Control4 Technical Support has been made to access the system on my.control4.com, 
AND you instruct the Controller to “check in” which you can do from the Navigator’s Control4 
Home page; select More > Settings > Remote Access. 

2.2.4 Set Up a 4Sight Subscription 
If you haven’t already done so, use the Control4® my.control4.com account to activate a subscription. 
4Sight lets you or your Control4 Dealer access your system remotely, or you can use the 4Store to 
purchase applications. 
 
Prerequisites 
You can obtain a 4Sight subscription for your system from your dealer, and then complete the 
following steps. 
 
To set up a 4Sight subscription: 
1. Obtain the 4Sight Subscription code for your system from your Control4 Dealer. (If you've set up 

the subscription yourself, you have the code.) 
2. Log in at http://www.my.control4.com under Account Login using your my.control4.com email 

address and password, and click Submit. 
  

http://my.control4.com/�
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3. From Account Administration, select the subscriptions link. 
4. Enter the subscription code, and then click Activate. 

  

 
 

2.2.5 Activate Composer HE 
The first time you start Composer HE, the software asks you for a subscription code. Ensure that 
you’ve registered your controller. 
 
To activate your Composer HE software:  
1. From your PC desktop, double-click the Composer Home Edition icon to launch Composer HE.  
2. Enter the subscription code provided with your Composer HE software. 
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3. Your Composer HE subscription code will be similar to this: DC89-D37F-D528-7A4A, four 4-
character sets separated by dashes. Enter the subscription code provided with your Composer 
HE package. 

4. Enter the email address and password associated with your 4Sight account. 
5. The email address and password must be the credentials associated with your 4Sight account at 

http://my.control4.com. 
6. Click Activate. 

2.3 Starting Composer HE 
The first time you start Control4® Composer HE, the system prompts you for your 4Sight account 
information and a Composer HE subscription code. 4Sight is the Control4 subscription Internet 
service. Be sure you register your account first so you can get this number, and then write the number 
down when you get it. 
 
To start Composer HE: 
1. You can log on two (2) ways: 

• Double-click the Composer HE 2.x.x icon on your PC’s desktop.  
• From the Start menu, select All Programs > Control4 > ComposerHE 2.x.x. The startup 

screen appears. 
 
Each time you start Composer HE, you will connect to your Control4 system either locally (click 
Director on Local Network) or remotely (Remote Director). On the Control4 system, the 
Primary Controller is the device with Director that you connect to from your PC. 
 
Note: To connect to a Remote Director, first you must set up Remote Access. See “Activating 
Composer HE.” 
 

http://my.control4.com/�
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Startup screen: 
  

 
  

2. Connect to a Director. 

2.3.1 Startup Options 
Use the Control4® Composer HE software installed on your PC to start the Composer HE application.  
 
Ensure that you've registered and activated your account before you start Composer HE for the first 
time. See “Activating Composer HE” for details. 
 
To start Composer HE: 
1. From your PC desktop, double-click the ComposerHE <version> icon to launch Composer HE.  
2. Enter the subscription code provided with your Composer HE software. The first time you start 

Composer HE, the software asks you for a subscription code. 
3. When starting Composer, you choose the type of Composer connection (local or remote) you 

want, and your Controller’s IP address.  
 

The Composer Startup screen presents these connection options. See the next section for 
details. 
• Director on Local Network—Choose this option when working while connected to the home 

network (inside the firewall). You can set up and design the project, make connections, add 
media, and program the system. 

• Remote Director—Choose this option when working remotely, but connected to a home 
network from the Internet (outside the firewall). You can change your Control4 system as if 
you were hooked up to the Local Network (second option). This requires Remote Access. 
See “Activating Composer HE” for details. 
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4. Connect to a Director. 

2.3.2 Connect to a Director 
Control4® controllers contain the Director software embedded in the controller that controls the 
communication of devices and allows the automation of your Control4 system. When you connect to a 
Director, you can define and customize the project for the system. 
 
Composer HE lets you access, create, and update project configuration. When you start setting up 
your Control4 system, you need to connect to a Director using either a local connection or a remote 
connection. 
 
When you close Composer HE, you have the option to make a backup on your PC by using the 
Backup As or Backup option from the File menu to save the project file. When you back up a project 
file, it is backed up to the “My Documents” directory on your PC by default. Create a filename that’s 
meaningful, for example, the project’s name and date. 

 
This section describes how to 

• connect to a Local Director, 
• connect to a Remote Director, and 
• grant access to a Dealer for remote access. 

 
Prerequisites 
1. Ensure that you set up your account at http://my.control4.com. 
2. Ensure that you have the correct setup, depending on how you want to connect. You can connect 

to Director two (2) ways: 
• Local Director. Your PC must be on the same IP-based local area network as your Control4 

system.  
• Remote Director. Your Control4 system must be configured to use 4Sight Remote Access. 

 
Note: If a Composer HE license is associated with this product, a 'Renew Composer Registration' 
screen may appear before you can connect to Director. If it does, type your email address, password, 
and then click Renew. 

2.3.2.1 Connect to a Local Director 
To connect to a Local Director: 
Connecting to a Director on the local network lets you configure current settings, download a new 
project, or back up an existing project to a file on the PC. Every Director has an associated network 
address.  
 
When you start Composer and connect to a Local Director, you are making “live” changes to the hard 
drive on the controller; and every time you connect to that Director, you see your project’s 
configuration. 
 
1. Start Composer.  

http://my.control4.com/�
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2. Click Director on Local Network. The Directors dialog appears when you choose to connect to a 
local Director.  

  

 
  

Options available on this page: 
• Connect. Lets you connect to the Director that resides on the controller connected to the 

local network. Shows the controller’s name and IP address. 
• Cancel. Cancels and closes the Director dialog box. 
• Add. Opens a dialog box that lets you add the Director’s Address of the controller to which 

you are trying to connect.  
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• Remove. Removes the controller from the Directors list. Select the controller to remove. You 
must click Add to add it to the list again. 

• Refresh. Lets you update the Director list to display recently-added Directors. 
  

3. From the dialog's list, select the IP address of the Primary Controller to access, and click 
Connect. The main page appears with the Monitoring and List View panes. 

2.3.2.2 Connect to a Remote Director the First Time 
If you've already connected to Director before, go to "Connecting to a Remote Director" (below) to 
connect remotely. 
  
To connect to a Remote Director for the first time: 
When you connect to a Remote Director, you are making “live” changes to a remote system controller. 
Changes will be made over an Internet connection rather than a local network connection.  
 
Note: This type of connection is not available until the initial configuration is complete. It requires 
either a temporary connection requested by Control4 Technical Support and granted by you, or a 
constant connection to the system made available by activating a 4Sight subscription.  

• Temporary Connection: If you are registered on my.control4.com, your controller 
registration is completed, and you have remote access. The system is accessible for 
temporary remote access, and will be made available to Technical Support personnel when 
you complete the Check In process. 

• Constant Connection: If you've purchased a 4Sight Internet Services subscription and 
activated the subscription for your controller through my.control4.com, then the system is 
always online and accessible for immediate remote access.  

 
Note: You may revoke access rights to Control4 Technical Support or your Control4 Dealer using 
my.control4.com at any time; this is not recommended, however, as it will interfere with needed 
regular updates. 
 
1. Start Composer. 
2. Click Remote Director. 
3. After your system is configured for 4Sight Remote Access, you can connect to it using Composer 

HE from any Internet connection by entering your 4Sight Account Name, E-mail Address, and 
Password. 

4. From the Director dialog that appears, choose the Director’s network address for the controller 
you are setting up, and click Connect. Choosing the Local Director is essential to Remote Access 
setup, as it defines to the system the controller you want to use to log in to the Remote Access 
Service. This step is done at your home to give you remote access in your system. If necessary, 
click Add to add the address manually. 

5. From the Tools menu, choose Account Services.  
6. If your system’s current status displays as Registered, you can choose the Check In option at the 

bottom of the screen to initiate a connection when requested by your Control4 Dealer or Control4 
Technical Support. The next time your system performs a routine check-in, a connection will be 
maintained until the Composer connection exits. If your system’s current status displays as 
‘Unregistered,’ complete the steps provided on the screen. 

http://my.control4.com/�
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2.3.2.3 Grant Access to a Control4 Dealer 
To grant access to a Control4 Dealer: 
1. To grant your Control4 Dealer access to your Control4 system, give the dealer access on your 

user list at my.control4.com.  
Notes:  
• Granting a dealer remote access rights to your account does not require that either you or the 

dealer reveals any confidential passwords. 
• See “Setting Up Remote Access” and “Registering the System on my.control4.com” for 

information. 
2. On the internet, go to http://my.control4.com, enter your email address and password, and then 

choose Submit. 
3. When you access your my.control4.com screen for the first time, follow the on-screen prompts to 

enter your 4Sight Subscription Code, and then click Activate. The 4Sight Subscription Code is a 
series of digits. Find this code on the card you received when you purchased your Control4 4Sight 
Subscription.  

4. When successfully activated, you will see an Account Subscription confirmation screen. The 
screen shows the information you used to activate your remote account. When you finish 
reviewing the confirmation screen, click OK. 

5. If you are connected to Web Navigator, choose Cancel or Close. 
6. In the My Account view with Account Administration selected (left pane), click the Profile link, 

and verify the Dealer of Record information. 
7. With Account Administration still selected, click the Users link. 
8. At the bottom of the page, check this option: Allow your dealer (your dealer’s name) to 

remotely access your system. 
9. To continue and connect remotely, see the next set of steps. 

2.3.2.4 Connect to a Remote Director 
To connect to a Remote Director: 
1. Start Composer. 
2. Click Remote Director. 
3. When your system is configured for 4Sight Remote Access, connect to it using Composer HE 

from any Internet connection by entering your 4Sight Account Name, E-mail Address, and 
Password after you connect to 4Sight. 

4. When the ‘Select Remote Account’ dialog appears, choose the account you want to access, and 
click Connect. If the MyControl4 account name is not in the list: 
a. Click Add to add the account name and click OK on the dialog that appears. This is the 

Account Name you created during registration at my.control4.com. 
b. When the ‘Select Remote Account’ box displays again, highlight your account, and click 

Connect. 
5. When the Connect <E-mail Address> dialog appears, enter your E-mail Address and Password, 

and then click Connect. A screen appears indicating that your account, email address, and 
password are being verified, which may take several minutes to complete. When authenticated 
and connected through the MyControl4 Remote Access Service, the list of Directors available for 
connection displays. 

6. Select the Director you want to connect to, and click Connect. 

http://my.control4.com/�
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7. When the remote connection is established, Composer HE opens in the Monitoring view. 
Composer HE functions normally as if you were connected to a local Director, allowing you to 
configure, program, and troubleshoot your system. 

2.4 Exiting Composer HE 
To exit the Composer HE  application click File > Exit. The software asks you if you want to save a 
backup of the project file. Click Backup or Backup As to save the project. Control4 recommends that 
you back up any changes you make to your project. 

3. Exploring the Interface 
The Control4® Composer HE interface and wizards are designed to help you 

• monitor your Control4 system, 
• maintain your media, and 
• add or modify custom programs. 

 
Composer HE main screen: 

 
  

To take advantage of the Composer HE features, learn about the following options in Composer: 
• Views 
• Menu options 

The Control4® Composer HE interface is divided into several panes (see above, for example, 
Monitoring and List View). 

  
The menu bar (File, Tools and Help) appears at the top of the window. 
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The upper left portion of the window displays a project tree and all views available (for example, 
Monitoring, Media, Agents, and Programming) in your system with the floors, rooms, and devices you 
will define depending on what you want to do. In the project tree, you can click to collapse or expand 
the floor, room, or device levels. 
 
The lower left portion of the window shows the view buttons. This is where you create automated 
tasks for your system:  

  
• Monitoring: Click to view the devices on your system, to access specific device controls, and 

to configure the properties of specific devices. 
• Media: Click to manage your digital music, movies, and other collections from a Disc Player, 

DVD or CD player, etc. 
• Agents: Click to configure an intelligent agent.  
• Programming: Click to create and modify custom programming for your system. 

3.1 Views 
Composer HE has four (4) main views (Monitoring, Media, Agents, and Programming). If you click on 
a view button, the appearance and functionality of the Composer interface changes to reflect the 
configuration options available for that view.  
 
Tip: Collapse the views by clicking and pulling down the dotted bar above the view buttons, giving you 
more room to view the project tree above. 
 
Note: The project tree has already been created for you by your Control4 Dealer or Installer to reflect 
the floors, rooms, and devices in your residence or business. If the project tree doesn't display, check 
with your Control4 Dealer. 
 
The Composer HE main views are:  

• Monitoring—View your system, your project tree and the devices in each room. 
• Media—Add and scan stored or broadcast media. 
• Agents—Use agents in the system and in programming. Agents include: Lighting Scenes, 

Wakeup, Scheduler, etc. 
• Programming—Program devices and agents on the system. 

3.1.1 Monitor and Control Lights, Thermostat, etc. (Monitoring View) 
The Monitoring view lets you view all of the devices and their current state for your system, rooms and 
devices. 
 
This view 

• displays a list all of the devices in a room, 
• displays the current state of contact inputs or other devices, and 
• lets you monitor and control the devices contained in the selected location of the project tree.  
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When selecting a site, building, floor, room, you can see all devices associated with each other in that 
area. If you select a device in the project tree, this view shows all devices that are in the same room. 
1. Click the Monitoring view in the Composer HE main window. Two (2) pages in this view show the 

‘List View’ screen, which gives you status information for all system devices at a glance: ‘List 
View’ and ‘Properties’. If the Control4 system is controlling/monitoring device power, the device is 
shown as Red when off, and Green when powered on. The light level, temperature, security 
system status, and other details are shown on this screen also.  
 
Monitoring view: 

 
 
2. Double-click any device in ‘List View’ to display the controls associated with that device. 
3. Click the Properties tab to access the ‘Properties’ page for all system devices. Select the device 

you want to change from the project’s tree view. For example:  
• Configure the LED colors on your Keypads. 
• Configure the LED colors, ramp rates, and preset level for your Dimmers. 
• Configure/program the ABCD buttons on your System Remote Control for each AV device. 
• Configure/program the Thermostat and its schedule. 

3.1.1.1 Project Tree (Left Pane) 
The Monitoring view contains the project tree, a hierarchical display of locations and devices. The 
project tree is where all of the device drivers for your devices reside in your project. Double-click on a 
device to access its device controls. 
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Monitoring pane: 

 

3.1.1.2 Device Control Window 
Access a Device Control window for supported devices by selecting and then double-clicking the 
device in the project tree of the Monitoring view. For example, if you select Left Dimmer in the project 
tree under Living Room, the following Device Control window displays. 
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Device Control window: 

 
  

The Device Control window: 
• lets you test and control a device (after identifying connections) from Composer.  
• provides you with a simple user interface for device control. For example, the device control 

for a Dimmer lets you click a button on the screen to turn the Dimmer on and off or change 
the light level. 

• lets you change the configuration parameters (temporarily) and control a device from 
Composer HE. Later, you can set the parameters permanently in the Properties pane or 
Programming view. For example, you can adjust the ramp rate of a Dimmer to determine the 
desired ramp rate to set during programming 

3.1.2 Manage Digital Music and DVD Collections (Media View) 
The Media view lets you:  

• add and scan your media selections to the system, including stored music and movie 
collections or broadcasts channels and stations. In the Media view, the left-side selections 
change the right-side views.  

• view and select stored or broadcast media from the Navigators (including On-screen 
Navigator, System Remote Control or Touch Screens that come in a variety of sizes). 

• set up playlists (playlists can be created at the Navigators). When you create or edit a 
playlist, you can pick albums or tracks to play.  

• search for cover art (when not loaded automatically) to enhance displays. 
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Media view: 

  
  

This list provides the media types for these categories: 
• Stored Media 

• CDs. Let you store CD cover art, albums, artist ratings, and genres (for example, Rock or 
Country). 

• DVD Player or Disc Changer. Lets you store DVD and CD (when DVD supports CD) 
selections by viewing cover art, titles, info, results, media, and disc list.  

• USB Driver or USB drive (CBM Flash Disk). Lets you store a variety of media and access 
it from one of these USB-connected devices. 

• MP3, AAC, or FLAC on Digital Audio Player. Lets you store MP3—HDD music cover art, 
albums, artist ratings, and genres (for example, Rock or Country). 

• Broadcast Media 
• DIRECTV. Lets you view DIRECTV channel options, including station IDs, genres, ratings 

and music channels. 
• Dish Network. Lets you view Dish Network channel options, including station IDs, genres, 

ratings, and music channels. 
• Cable TV. Lets you view Cable TV channel options, including station IDs, genres, ratings, 

music channels. 
• UHF/VHF. Lets you view the UHF channel options, including station IDs, genres, ratings, 

and HDTV. 
• AM/FM/XM and Internet Radio. Lets you scan AM, FM, Internet radio, and XM stations. 

 
1. Click the Media view. The Media Source devices display.   
2. Select any source device to modify the media list for that device.  

• Scan for new music on your network devices: configured USB-attached storage device or a 
configured network file store on any network-connected PC. 



 

Composer HE Getting Started 

 

 

 
Copyright © 2012 Control4. All Rights Reserved. 

 
 

Saved: 11/7/2012 1:16:00 PM  200-00169 Composer HE 
Getting Started 

Page  29 of  47 
 

 

• Scan for a new DVD in a configured Sony Disc Changer. 
• Search for media information using the media lookup service. 
• Manually customize your MP3, FLAC, or AAC-formatted albums and songs. 
• Manually add, edit, or delete your DVD information. 
• Search for the channel lineup on your cable, satellite, or off-air programming service. 

Manually edit your channel lineup. 
• Create playlists. 
• Export media lists for backup purposes or import media lists. 
• Export playlists for backup purposes or import playlists. 
• Set up Internet radio (your Dealer can do this for you). 

3. To add new MP3 files to your collection, copy the MP3 files to a configured storage location on 
your USB-attached storage device or a configured network storage device.  

4. To add a new storage device, have your Control4 Dealer add it to the Composer project and 
configure it for your use. 
• The network address of the controller used for your MP3 files is \\<ipaddress>\media\audio 

where <ipaddress> is your controller's TCP/IP address (for example, 192.168.0.100). To 
copy MP3 files from your PC to the controller, open that directory in Windows Explorer and 
copy the files to a directory in that location. 

• After you copy the files, use the Media view to select the storage device, and then select 
Scan to add them to your Media list. 

• Customize, if necessary, the metadata for the newly-added media. 

3.1.3 Use Intelligent Agents (Agents View) 
Agents let you perform more complex programming by using functional modules. For example, the 
Scheduler agent lets you program an action using dates and times. 
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Agents view: 

 
 
Available agents:  

• 4Store 
• Access 
• Advanced Lighting Scenes 
• Announcements 
• Custom Buttons 
• Email Notification 
• Intercom 
• Lighting Scenes 
• Macros  
• Media Scenes 
• Rhapsody 
• Scheduler 
• Screen Saver 
• SNMP Configuration 
• Timer 
• Variables 
• Video Wall 
• Wakeup 

  
See “Agents Types” in the Composer HE User Guide for a definition of each agent with examples. 
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This list shows the options available on some agents: 
• Add—Lets you add agents to your system. Note: Your dealer will need to do this for you. 
• Remove—Lets you remove agents from your system.  
• New—Lets you create a new instance to customize the highlighted agent in the Agents pane 

(left pane). For each specific instance of an agent, you provide a unique name and customize 
it for the specific need. 

• Copy—(Lighting Scene only.) Lets you copy an existing instance of the highlighted Lighting 
Scene agent. 

• Delete—Lets you remove an existing instance of the highlighted agent. 
• Agent Navigation pane—Provides each agent a unique interface to set up agent information 

in a majority of cases for future programming in the Programming view. 
 
Click the Agents view in Composer HE.  
 
Configurable agents: 

• 4Store—Set up and manage 4Store logins, apps, themes, and storage. 
• Access—Show or hide icons on your Navigators using a pass code. 
• Advanced Lighting Scenes—Control lighting throughout your residence or business from 

any device—On-Screen Navigators, Touch Screens, and tablets. 
• Announcements—Create an announcement to display on the Touch Screens, MyHome 

apps, or On-Screen Navigators. 
• Custom Buttons—Shown on the Navigators. You can create up to four (4) screens with six 

(6) buttons each to show on the Navigators in specific rooms or in all rooms in the system. 
Use programming to link the Custom Button events to the actions you'd like to perform. 

• E-mail Notification—Send email to any Internet mail address. Use Programming (requires a 
4Sightsubscription and remote access enabled on the Controller) to send out the notification. 

Notes:  

1. Remote Access is required to use the E-mail Notification Agent. Check with 
your dealer for details about using Remote Access. 

2. Avoid setting up email notifications for events that occur frequently (e.g., when 
a Motion Sensor detects motion). If the email notification trigger event occurs 
too often, it will cause the system to become sluggish. 

• Intercom—Sets up the Intercom system for 5" or 7" In-Wall Touch Screens, the 7” In-Wall 
Touch Screen with Camera, 7” Portable Touch Screen with Camera, or the Door Stations. 

• Lighting Scenes—Customize Lighting Scenes according to your needs. 
• Macros—If you create a programming script for use in several places, you can use macros 

rather than having to create new programming scripts every time. 
• Media Scenes—Create and configure Media Scenes which are used to link rooms in your 

system for audio functionality. Activate and deactivate Media Scenes using the Agents or 
Programming views. 

• Rhapsody—Set up Rhapsody and access the Rhapsody account (requires a Rhapsody 
account). 

• Scheduler—Schedule events to which you can attach programming. Scheduled events can 
be based on specific time of day, day of week, and sunrise/sunset times. 
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• Screen Saver—Create a new Screen Saver to use on your Touch Screens and On-Screen 
Navigators. 

• SNMP Configuration—Manage Control4 home networks remotely. 
• Timer—Create a timer to enable or disable devices at set times. 
• Variables—Create variables to use in programming. You can create number variables 

(numeric), true/false variables (Boolean), and text variables (string). 
• Video Wall—Control several TVs mounted on a wall. 
• Wakeup—Incorporate your music selection, light level and ramp rate, and temperature 

control to wake you up. 
 
See “Agents” in this guide or the Composer HE User Guide for more details. 

3.1.4 Program the Control4 System (Programming View) 
For the Control4 system to control its devices, you need to configure the behavior of those devices to 
occur automatically in the Control4 system. The Programming view lets you write a programming 
script using Composer’s drag-and-drop or double-click functions.  
  
Programming view: 

 
  

All programming is based on events and actions in a Control4 system. For example, if a door opens, it 
is an event. When an event occurs in the system, it can trigger programmed actions to take place. For 
example, when the bathroom door opens (event), you can program the bathroom light to turn on 
(action). 
  
The Programming view consists of several panes: 

• Device Events and Project Tree (top left pane)—Displays all devices that have associated 
events.  
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• Events (bottom left pane below the Events project tree)—Displays the available Events for 
the currently-selected device in the Events project tree. If there are no events for that device, 
none are displayed. 

• Script (center pane)—Displays the Script that is associated with the currently-selected event 
from the Events pane. Drag and drop items to rearrange the order and nest items in the 
Script pane. 

• Device Actions (top right pane)—Displays all available device options (in tree form) that 
have associated actions you can use to write your script. 

• Actions (bottom right pane)—Displays the selection of the Command, Conditionals, and 
Loops tabs you can select to move to the Script pane. To add an action to the script, select 
the action, and then click or drag-and-drop the green arrow or blue question mark to add 
the script to the Script pane.  

 
See the Composer HE User Guide for details about how to create a script. 
 
Click the Programming view in Composer HE. Programming actions occur based on specific events 
in the system to make it easy to use and powerful. 
 
Basics concepts for programming: 

• Devices—Each device in the system is seen from two (2) perspectives: functions that occur 
on the device (event) and functions that can be done to/using the device (action). The 
‘Device Events’ pane on the left side of the Programming view shows the events for each 
selected device. The ‘Device Actions’ pane on the right side shows the actions for each 
selected device. Devices include not only the physical devices on the system, but also the 
logical devices, for example, rooms and agents. 

• Events—When anything occurs on the system, it is an event. Most system events can have 
programming attached to them. Notice the specific events that occur on each device as you 
select devices. For example, the Control4 Wireless Dimmer has several events associated 
with it: Top Button Pushed, Top Button Released, Bottom Button Pushed, Bottom Button 
Released, and so on. The event is the fundamental trigger used in Control4 system 
programming. 

• Actions—An action is a specific task that the system can perform. Actions are also device 
specific. For example, the Control4 Wireless Dimmer can be set to turn on/off, can be 
toggled, can be set a specific dim level and ramping rate, can be configured with custom LED 
colors, or can be set to force the button press/release events to fire. 

• Commands—A command is a specific action inserted into the programming script (to the 
‘Script’ pane). 

• Conditionals—Most devices can be evaluated on a conditional basis. For example, the 
conditionals that you can use on the Control4 Wireless Dimmer are: is the light on, is the light 
off, is the light level greater than, equal to, less than, or not equal to a specific level? The 
power of conditionals lay with your ability to use conditionals to create programming which 
starts with and evaluates current conditions, and then proceeds accordingly. 

• Script—The script is the ordered set of conditionals and commands which you associate with 
a specific event. Scripts appear in the ‘Script’ pane as you add them. When an event occurs, 
the Control4 system executes the script associated with the event. 

• Variables—You define variables when you create a Variables agent in the Agents view. 
There are three (3) types of variables you can use in programming: 

http://www.control4.com/residential/products/resources/�


 

Composer HE Getting Started 

 

 

 
Copyright © 2012 Control4. All Rights Reserved. 

 
 

Saved: 11/7/2012 1:16:00 PM  200-00169 Composer HE 
Getting Started 

Page  34 of  47 
 

 

• Numeric—Use Numeric Variables for counting up, counting down, or setting values 
based on a number. 

• Boolean—Use Boolean Variables to set and track true/false values. For example, when 
the Scheduler sunset event fires, you can set a user-defined Boolean variable called 
Night_Time to true. When the Scheduler sunrise event fires you can set Night_Time to 
false. 

• String—A String Variable contains a text string. You can set and evaluate string variables 
in programming. For example, you can set a user-defined string variable called 
Selected_Playlist equal to "Exercise Music." 

• Room Variables—In addition to the user-defined variables you can create, the system also 
has system variables attached to each room which you can use when you program your 
system. Room Variables are most commonly accessed as commands and conditionals from 
the Room device. However, a full set of Room Variables is also available for each room on 
the system. 

• Programming Control—Use the Programming Control commands to delay or stop script 
execution. 

Example: Below is an example that demonstrates some of these concepts. When you start playing a 
DVD in the Living room, if it's evening, you want to ramp the lights in the room gradually to 15%. 
When the DVD is stopped or paused, the lights automatically ramp up to 50%. When the DVD plays 
again, the Dimmer level goes back to 15%. Can you identify from this described behavior what the 
events, conditionals, and commands are? 
 
The following steps demonstrate how you'd create the programming for the previous example. 
1. There are three (3) Events: DVD Play, DVD Stop, and DVD Pause. 
2. The only Conditional to check is night time. 
3. Actions are added to the Script pane by either double-clicking or dragging and dropping the 

Action’s arrowhead or question mark into the Script pane.  
4. The Commands are Dimmer ramp commands. 
5. You can drag and drop a Command arrowhead on top of a Conditional question mark to “nest” (or 

indent) the Command. 
  

The following examples show Stop and Play commands. Detailed information about how to program 
the system is in the Composer HE User Guide. 
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3.1.5 Menu Options 
Use the Composer HE menu bar to perform basic file tasks, view the network tools, and view the 
online help. 
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Menu options: 

 
  

The Menu bar provides the following menus: 
• File—Perform typical file management tasks, load a project, connect to or disconnect from 

the Local Director,  refresh the Navigators, back up the project, or exit Composer HE. 
• Tools—View network status and logs and account information. Note: Updates are not 

supported in Composer HE. 
• Help—View the Composer HE Getting Started online help and Composer HE version 

information. Links to the Composer HE User Guide are provided in the online help. 

3.1.6 File 
The File menu lets you perform project file management tasks, load a backed up Composer HE 
project, connect to Director, refresh the Navigators (including the Touch Screens and On-Screen 
Navigators), create a backup, or exit Composer HE. The file management options relate to the 
Composer HE project files you back up on your PC (they have a .c4p extension).  
When you set up a Control4 system, you create live project configuration information on the controller 
that is backed up to a project file on your PC. This lists specific information about each system, 
including devices, connections, configuration, programming information, and media.  

• Load Project—Loads a selected project into Composer HE. Composer HE prompts you for a 
backup before it clears the project configuration information, and replaces it with the selected 
project to load from your local drive. 

• Connect to Director—Connects you to the selected Director residing on the controller if 
there is more than one Director in the network. Composer HE prompts you to back up your 
project before connecting another Director. When you connect, project configuration 
information from the controller appears on the Composer HE screen. 

• Disconnect from Director—Disconnects you from Director. Composer HE prompts you to 
back up your project before disconnecting you from the currently-connected Director. This 
option is available when connected to Director. 

• Backup—Backs up the current project to your connected PC. The first time you back up, the 
software prompts you for a file name and to back up any media information (recommended). 
When you choose this option, the current project becomes an option in the File > Load 
Project list. 

• Backup As—Backs up the current project, and prompts you to enter the name of the file. 
Composer HE prompts you to back up any media information (recommended). When you 
choose this option, the current project becomes an option in the File > Load Project list. 

• Refresh—Refreshes the Composer HE screen with the current project configuration 
information from Director. 

• Refresh Navigators—Refreshes the Navigator screens with the current project configuration 
information from Director. Note: MyHome-PC/Mac and tablets must be updated in the 
MyHome app. MyHome for iPhone, iPod touch, iPads, and Androids will update if online. 

• Exit—Exits Composer HE, and prompts you to back up the project before the software exits 
and returns you to the desktop.  
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3.1.7 Media 
Note: The Media menu appears only when you select the Media view.  
The following options are available: 

• Clear Media List—Clears the media list associated with the highlighted device from the 
Media Database.  

• Export Media List—Exports a media list for the selected device from your controller to your 
PC. 

• Import Media List—Imports a media list from your PC to your controller.  
• Export Playlists—Exports a playlist from your controller to your PC. 
• Import Playlists—Imports a playlist from your PC to your controller. 
• Import DVD List from File—Imports an Excel list of DVDs for Disc Changers. 
• New Playlist—Creates a playlist of MP3, AAC, or FLAC files. The playlist is available from 

any Touch Screen or On-Screen Navigator. Add albums, remove songs, re-order songs, etc. 
Note: If you remove songs from a playlist, it does not remove them from the Media Database. 

• Delete Playlist—Removes a playlist.  
• Rename Playlist—Renames a playlist. 
• Tag media files—Converts media files so all media players can see the same tags. 

3.1.8 Tools 
The Tools menu lets you access some tools for checking device connection status: 

• System Diagnostics—Assists you to gather system information and help determine if any 
issues encountered are configuration problems, performance issues, or potential defects. 
The System Diagnostic tool is also valuable for logging information and sending an email 
message to Control4 Technical Support. See "System Diagnostics" below. 

• Account Services—Facilitates system registration which is required for software updates 
and to use the media services in the system. Account Services is also required in conjunction 
with a 4Sight account to enable the remote access web service (which allows secure access 
to your system via the Internet). See "Account Services" below. 

• Update Manager—Check with your Control4 Dealer or Installer for details about this option. 

3.1.8.1 System Diagnostics 
Controller Performance Tab—View controller performance information including CPU and memory 
usage. 
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Controller Performance History Button—View the history of CPU and memory performance. Click 
the History button on the lower right of the screen. 
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Controller Networking Tab—View controller networking information, including the network type, 
connection status, MAC address, IP address, Subnet mask, Gateway, DHCP status, and DNS server 
information. 

  

 
  

Test Internet Connection Button—Click to test the current Internet connection. 
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System Info Tab—View System information. Click Save To File to save the displayed text to a file. 
  

 
  

Logging Tab—Reproduce (if possible) and log system problems. 
  

 
  

Start Logging—Logs the system information. 
Stop Logging—Stops logging the system information. 
Open Controller Log—Opens the log file if system information was logged. 
Auto Scroll Output—Allows the output to scroll through automatically.  
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3.1.8.2 Account Services 
Set up a my.control4.com account and register a controller. Check the current status and establish a 
service connection. 

• Controller Registration (Register/Unregister) 
• Current Status 
• Service Connection (Check In) 

3.1.9 Help 
Use the help menu to access the online version of this Composer HE Getting Started document with 
Index, Glossary, and search options. Also, you can check the version of your Composer HE software 
and Director. 
 
From the Help menu, you have the following options: 

• Contents. Displays the Content tab of the Help system.  
• Index. Displays the Index tab of the Help system.  
• About Composer. Displays the Composer HE and Director versions. 

4. Where to Go from Here 
Refer to the Composer HE User Guide on the Control4® website (available as web help or PDF). The 
user guide provides in-depth information about how to monitor and program your Control4 system. If 
you are using online help in Composer HE, links to the Composer HE User Guide are provided from 
the help topics. 
 
Control4 strives to support Control4 Dealers so they can support you. If you have questions or need 
assistance beyond what is provided in this Composer HE Getting Started or the Composer HE User 
Guide, please contact your Control4 Dealer.  
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5. Glossary 
4Sight: An Internet service that provides a connection to the Home-Automation System any time and 
from any place worldwide. 
4Store: The Control4 App Store where you can buy applications for your system. The applications 
appear in the Touch Screens or On-Screen Navigators under More > Settings. 
AAC: Advanced Audio Coding. A successor to the MP3 format. A standard, lossy compression and 
encoding scheme for digital audio. Touts better sound quality. 
action: An activity that occurs when an event prompts it to do so. 
agent: In Control4 programming, agents provide the ability to perform complex programming by using 
functional modules. There are various types of agents; for example, Announcements, Email 
Notifications, Scheduler, Lighting Scenes, Wakeup, etc. 
AV: Audio Video. 
CD: (Compact Disc) - An optical disc that stores digital data. This format is compatible with Control4 
products. 
client: A software or hardware device that communicates to a server for feedback from the server via 
an application for the user. 
Command: A ‘do’ statement; actions the Director communicates to a device. 
Composer: The Control4 software used to design and define a Control4 Home-Automation System. 
Composer Pro: Composer Pro is used to set up and configure Control4 devices to communicate with 
each other in a home-automation system. The dealer uses this software to create and configure the 
project for the customer. 
conditional: An ‘if’ statement that asks a true/false questions which are acted upon in Composer 
programming. 
connection: Binding or linking devices together in Composer so they can communicate with each 
other. 
contact: Contacts are generally used to monitor the status of something (door, window, water sensor, 
etc.) and can be hooked up through a security panel or directly using a Control4 controller or 
Contact/Relay Extender. Contacts connected to a Control4 Controller or Contact/Relay Extender can 
be configured either as NC (normally closed) or NO (normally open). 
Control4 system: A Home-Automation System designed and developed by Control4. 
Controller: The main device that makes Home Automation possible. There may be multiple 
controllers within a Control4 system. The controller that runs Director is referred to as the Primary 
Controller. The other controllers in the system are Secondary Controllers. 
device: A component that requires a device driver; code that is used to allow the Control4 system to 
work with that device. Device drivers are added to the project tree in Composer by the Dealer. 
device driver: Every device in the Control4 system needs a corresponding device driver to control 
that device. 
DHCP: DHCP (Dynamic Host Configuration Protocol). A protocol used between a network client and 
a DHCP server (usually a router or access point) that dynamically assigns IP addresses from a pre-
defined list to clients on a network. 
Director: Each Control4 controller (such as an HC-800 Controller) ships with pre-installed Director 
software (Linux based) embedded in the device. The Director communicates with Control4 products 
and third-party products to enable Home Automation and interaction of individual devices. Director 
runs the Control4 devices. Composer Pro is the software used to connect to and program a system 
Director that resides on a controller. 
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DriverWorks: The DriverWorks SDK is used to create two-way drivers for audio video (AV) and non-
AV devices. 
DVD: (Digital Versatile Disc) – A media format for video and data storage. 
end point: The end point is the final point (device) on the defined path over which audio and/or video 
content is routed to a room. An example of this would be a TV or Receiver. 
Ethernet: Uses Ethernet category 5 (CAT5 or CAT5e) wiring to transfer data. Ethernet uses a star 
network topology that allows multiple points to communicate to a single point. The Speaker Point® 
uses Ethernet to communicate to the Control4 controller. 
event: An action; used to trigger Composer programming when programming Control4 devices. 
file format: A format used by applications to store/read files. 
FLAC: Supported by Control4 for software release 1.8 or later; this is a free, open source, lossless 
audio codec format that supports tagging, cover art and fast seeking. Audio is compressed with no 
loss in quality. 
gateway: (router)- Provides a means of communicating between two separate networks. 
home network: A network installed in the customer’s home that provides an Ethernet or wireless 
connection so that Control4 devices can communicate with each other. 
Home-Automation System: The Control4 system: a line of Home Automation products that 
communicate with each other over Ethernet, WiFi, or ZigBee for a total Home Automation experience. 
identify: Your Control4 Dealer or Installer will identify a device to the Control4 system after they add 
the device driver  to the project tree. This ensures that the device can communicate with the Control4 
Controller and Director. 
Intercom: A two-way audio and/or video communication among supported Control4 devices. 
Interviewer Wizard: An automated setup program in Composer that builds a project for Home 
Automation. 
IR: A device controlled using a wireless remote control device. Commands are sent via pulses of 
infrared light to the device. 
LCD: (Lighted Crystal Display) - A display used with some Control4 interfaces. 
LCD Navigator: An LCD device used to control lighting, music, videos, etc., on an LCD screen. 
LED: (lighted electronic display). 
Linux: An operating system used by several Control4 devices. 
List Navigator: A System Remote Control device uses a Navigator that lists the options. 
Live Connection: A term used in Composer Pro to indicate an actual connection to the network. 
Loop: A type of conditional in programming; a ‘while’ statement; for example, “while the sprinklers are 
on…” 
Media Database: Media information is stored in the Media Database, which will permit users to view 
the media from the Navigators. 
MP3: A music format that makes streaming audio available. 
Navigator: A Control4 Navigator used with the Control4 system to control lights, music, videos, etc. 
Navigator is software that the customer interacts with using a Universal Remote Control, On-Screen 
Navigator, or Touch Screen. 
On-Screen Device: Allows you to select the controller (e.g., HC-800 Controller) in the room that 
controls the source for the on-screen display. 
playlist: A list of songs compiled in a list. The list can be compiled by songwriter, album, song type, or 
any combination. 
Power Over Ethernet (POE): A Control4 device that is Ethernet controlled. 
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Primary Controller: The main device that makes Home Automation possible. There may be multiple 
controllers within a Control4 system. The controller that runs Director is referred to as the Primary 
Controller. 
programming: A machine-readable artificial language used to express computations that can be 
performed by a device. 
project tree: A tree view in Composer where the project is layered by the larger branches (Home, 
Office, etc.) and then the lower branches (floor, rooms, etc.), and finally to the leaf level (drivers). 
ramp rate: The rate that a Dimmer ramps up its voltage. 
relay: An electrical switch that opens and closes. A relay is controlled by another electrical circuit. 
remote access: The ability to access a device from a remote location. 
Remote Director: Connects you to the home network while working in Composer from a remote 
location. 
retrofit: The ability to set up a Home-Automation System in an existing structure or home. Compare 
this with new building construction. 
RJ-45 jack: An eight-pin jack used to connect CAT5e network cables to devices through Ethernet 
signals. 
router: See gateway. Functions similar to an AP but with additional functionality for controlling the 
network; for example, coordinating traffic between different networks. 
Secondary Controller: Other controllers in the system that do not run Director or are used as the 
Primary Controller. 
serial-controlled device: Serial-controlled devices with an RS-232 interface and control protocol 
often have a higher level of controllability than IR-controlled devices. Examples of serial-controlled 
devices are projectors, multi-disc DVD changers, etc. 
switch: An extension of a router that adds more Ethernet ports to support additional devices or clients 
on the local network. 
system event: An action that causes another action; for example, if a projector turns on, it enables 
the other devices in the system that work with the projector. 
system remote: System Remote Control. 
System Remote Control: A Control4 System Remote Control is a universal solution that replaces 
System Remote Control devices from other manufacturers, and includes programmable buttons. This 
System Remote Control can access On-Screen Navigators. 
Touch Screen: A Touch Screen is a Home-Automation System Navigator that controls the home’s 
lighting, music, videos, and other devices on the Home-Automation System. 
UI (user interface): The preferred term is Navigator. The Control4 interface, used with Control4 
devices to control Home Automation, such as Touch Screens or On-Screen Navigators. 
universal remote: Universal remote control. A third-party remote control that can be programmed to 
replace other remotes in the home so that only one remote is needed, replacing all others. Control4 
System Remote Control devices are a type of universal remote control. 
USB: Universal Serial Bus) - A format used with USB sticks that plug in to a USB port on Control4 
devices. 
Virtual Connection: A term used in Composer Pro to indicate a connection outside the network. 
Virtual Director: A connection to a virtual controller only (a PC is the Director host rather than the 
Controller). Projects created or edited here are benign until the saved project is loaded onto a 
controller. 
WiFi: Uses bi-directional wireless technology to transfer data. WiFi (wireless fidelity) devices 
“connect” to each other by transmitting and receiving signals on a specific frequency of the radio band 
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using a wireless access point. This technology uses the star network topology. WiFi uses high 
bandwidth 802.11. 
wired network: Uses Ethernet Category 5 (CAT5) wiring to send and receive data between devices 
connected to a network. 
wireless access point: A router extension with an antenna that communicates with WiFi devices and 
clients in the home. A wireless hub that connects to a wired network and distributes a wireless signal 
throughout the structure. 
Wireless Switch: Uses the ZigBee. UL listed dimmer. Single or multi-gang. Has an air gap to cut 
power. 
WLAN: Wireless local area network. 
ZigBee: A wireless network that uses bi-directional wireless mesh network technology to transfer 
messages from one device to another. Unlike a star network topology where devices can only send 
messages to each other by sending them first to a single central device (which then delivers the 
message to the recipient device), a mesh network topology allows the devices to forward messages 
from one device to another, thereby extending the effective range of the network. Uses low bandwidth 
802.15.4. 250 devices are allowed per controller but Control4 recommends 125. 
ZigBee Pro: The 1.1 version of ZigBee that provides improvements in standardization by: allowing 
more interoperability with other Control4 devices, support for home automation profiles, and improves 
the scalability of multiple ZigBee access points. 
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Delete Playlist, 37 
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Director on Local Network, 19 
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Exit, 37 
Exit Composer, 9 
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Export Media List, 29, 37 
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File menu, 19, 36 
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Get started, 9 
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Import Media List, 37 
Import Playlists, 37 
Inoperable system, 9 
Install Composer HE, 10 
Launch Composer HE, 16 
Legal Notice, 2 
List View, 25 
List View screen, 25 
Load a project file, 9 
Load Project, 36 
Local connection, 19 
Logging Tab, 40 
Macros agent, 7 
Media Database, 9 
Media Scenes, 7 
Media view, 24, 27, 28 
Menu Options, 35 
Monitor, 7 
Monitoring view, 24, 25 
MP3 files, add new, 29 
MPEG, 2 
My Documents 

Backup file, 19 
Network device, 29 
Network file store, 29 
New Playlist, 37 
Open Controller Log, 40 
Playlist, 29 
Playlists, 9 
Programming, 9 
Programming example, 34 
Programming view, 24, 32 
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Programming Control, 34 
Room Variables, 34 
Script, 34 
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Variables, 34 
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Project Tree, 25 
Properties, 25 
Properties page, 25 
Refresh, 36 
Refresh Navigators, 36 
Register Controller, 12, 14 
Remote Access, 14 
Remote connection, 19 
Remote Director connection, 22 
Rename Playlist, 37 
Requirements, hardware and software, 11 
Restore the system, 9 
Restrictions, 8 
Scan, 29 
Scan for new music, 29 
Scan media, 27 
Scheduler agent, 7 
Search, 29 
Search for Cover Art, 27 
Select Remote Account, 22 
Set up playlists, 27 
Sony Disc Changer, 29 
Start Composer HE, 10, 17 
Start Logging, 40 
Stop Logging, 40 
Stored Media, 28 
Subscription code, 16 
System configuration, 9 
System Diagnostics, 37 
System Info Tab, 40 
Tag media files, 37 
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